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Creating and Using Art
on the Web
After completing this lesson, you will be able to:

n Comprehend the basics of Web graphics.

n View and manipulate Web graphics in a graphics program.

n Describe the different types of graphics file formats.

n Choose “safe” colors for the Web.

n Crop a graphics image.

In this lesson, we simplify the topic of Web graphics. In a perfect world, we’d dedicate
pages and pages to the nuances of using graphics on the Web (mostly because we like
graphics), but then you’d never get to the rest of the lessons. We also don’t want you to
feel overwhelmed when it comes to using Web graphics. As you might have discovered,
you can easily find an overabundance of information about advanced graphics by looking
on the Internet and in bookstores everywhere. Fortunately, you can use Web graphics effec-
tively without immersing yourself in gamma theory and rasterizing. Therefore, we’ve opted
to take the practical approach of presenting what we deem to be the most significant and
fundamental information about Web page graphics. Think of this lesson as your personal
crash course in Web art. By the time you reach the “Key Points” section at the end of the
lesson, you’ll have plenty to think about, a few tricks up your sleeve, a cocktail party quip
or two, and a number of places to turn to during your search, acquisition, creation, and
preparation of Web art.

Practice files for this lesson can be found in the Lesson03 folder in the Web Design Fun-
damentals Practice folder that is located on your hard drive.  The files used in this lesson
include the following: apples.jpg. cherries_photo.jpg, cherries.gif, firebreath.gif, pal-
ette216.gif, fruit_standard.jpg, fruit_compressed72.jpg, fruit_progressive.jpg, and
fruit_progressive_compressed72,jpg.

Mechanics of Web Graphics
Before you start flipping through this lesson to check out the pictures and unearth the ad-
dresses to our online examples, you really need to read this section to make sure you un-
derstand a few key Web graphics issues. As you know, Web graphics look fairly similar to
printed graphics, but some Web-specific factors come into play when you’re creating and
using graphics on the Web. Specifically, online graphics require you to consider color limi-
tations, file formats, and file sizes as well as possible transparency, downloading, and ani-
mation issues. Acquiring an awareness of three main factors—colors, file types, and file
sizes—enables you to begin using graphics on your Web pages and provides a jumping-off
point for further graphics study. Therefore, the overall plan of attack here is to tuck some
Web graphics fundamentals into a cranial corner or two before opening your mind to the
more creative (and fun) prospects of using, gathering, and creating Web graphics. Let’s get
started by looking at how graphics display color.

Pixels, Palettes, and Colors

First and foremost, every online graphic consists of a bunch of tiny colored squares work-
ing together to form an image. In a way, online graphics emulate a painting technique
called pointillism. Pointillism, introduced by French painter Georges Seurat (1859–1891),
is the art of painting pictures one dot (or tiny brush stroke) at a time. Through pointillism,
Seurat broke each image on his canvas down into tiny dots of color. When you look
closely at a pointillist painting, you can see each dot. As you move away from the paint-
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Lingo: A pixel is one square
on a grid of thousands of
squares that are individually
colored to create an image.
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ing, the dots blend together to create a picture. Computers display pictures using a tech-
nique similar to pointillism, except that instead of painted dots, computers divide pictures
into colored squares, called pixels. For example, take a look at the cherries in Figure 3-1.
Figure 3-1 could be any graphic displayed on your screen. As you can see, the graphic
looks like most other pictures online (or in printed material, for that matter), and there are
no blatant signs of dots, squares, or
pixels.

Figure 3-1.
A couple cherries stand in as a typical graphic.

Now let’s look at the graphic a little more closely. In the Lesson03 practice files folder for
this course, locate cherries_photo.jpg and open it in a graphics editing application such as
Jasc Paint Shop Pro, Adobe Photoshop, or Microsoft Paint. If you then dramatically mag-
nify the image, you’ll be able to see the actual squares (pixels) that make up the picture, as
shown in Figure 3-2. If you magnify the cherries on your monitor, you’ll see that the pic-
ture’s colors and shades vary from pixel to pixel, or square to square.

Tip
If you don’t have a graphics editing application on your system or if you want to test-drive
a popular “full-service” graphics editing application, visit www.jasc.com and download a
free trial version of Paint Shop Pro. We have more to say about graphics editing applica-
tions later in this lesson.
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Figure 3-2.
When you magnify an online image, you can see the image’s pixels.

Try This!
With cherries_photo.jpg still open in your graphics program, enlarge the picture by using
your graphics program’s Zoom Tool or Magnifying Glass. To further illustrate how pixels
work, incrementally decrease the image’s view (or “zoom out”) to a slightly more viewable
size, as shown here:

If you zoom out slowly, you can see how the pixels start to blend to create a clear image.

Now that you know about pixels, we can talk a little about palettes. A palette is simply
the table of colors used in a graphic. Some Web graphics (namely, graphics saved using the
GIF file format, as described in the next section) use a limited collection of colors. You
can assign a palette to an image, or you can let your graphics program generate a palette
automatically as you create and edit an image. A GIF palette can hold up to 256 colors, but
many images use fewer colors than that. For example, looking at Figure 3-3, the cherries
graphic uses 8 colors and the hot pepper graphic uses 128 colors. Notice the pictures’
sizes—the cherries graphic is 3 KB (very small), and the hot pepper graphic is 7 KB (al-
most as small as the cherry GIF graphic).

Lingo: A palette holds the set
of colors used in a graphic.
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Figure 3-3.
The cherries graphic’s palette contains 8 colors, and the hot pepper graphic’s palette con-
tains 128 colors.

Generally, most graphics applications enable you to view the colors included in a GIF
graphic’s palette. Furthermore, you can reduce the size of a GIF image by reducing or lim-
iting the number of colors in the picture’s palette. And, as you probably know, smaller file
sizes equate to quicker download times on the Web.

Lingo: In some Web graphics
applications and documenta-
tion, a palette is also referred to
as a color look-up table
(CLUT) or simply a color
table.
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Try This!
In the Lesson03 practice files folder for this course, locate cherries.gif or firebreath.gif and
open either graphic in a graphics editing application such as Jasc Paint Shop Pro, Adobe
Photoshop, or Microsoft Paint. To display the image’s palette in Paint Shop Pro, select
Edit Palette from the Colors menu. In Photoshop, select Mode from the Image menu, and
then select Color Table. (We realize that every graphics package has its own menu options;
we provide the preceding two commands to give you an idea of the type of command you
should look for in your graphics application.)

As we just mentioned, palettes come into play when you use GIF images. We realize we
haven’t defined GIFs yet—or any Web-friendly image formats for that matter. Now that
you have a feel for the nature of pixels and palettes, however, let’s move on and discuss
graphics file formats that you can use on the Web. We’ll talk more about palettes when we
discuss GIFs later in this lesson.

Graphics File Formats

As you might recall, in Lesson 1 we said that every graphic on a Web page is stored as a
separate file. As a refresher, turn again to Figure 1-4 in Lesson 1. Notice the names of the
two image files used in Figure 1-4.

The title bar figure’s file name ends with a .gif file extension (afs_title.gif), and the other
figure’s file name ends with a .jpg file extension (4members.jpg). Graphics file extensions
work on the same principles as other file formats. For example, if you see a file on your
desktop named holiday_gift_list.doc, you know by the .doc extension that the file is
probably a Microsoft Word document, and you’ll want to open the document in Word (es-
pecially if you suspect that you’re one of the people listed on the holiday gift list!). Simi-
larly, if you see a file on your desktop named bills.xls, you know the .xls indicates a
Microsoft Excel document, so you could open the file in Excel (although you might want
to avoid files named bills). In relation to Web graphics, your Web pages can include graph-
ics images that use the .gif and .jpeg (or .jpg) file extensions because most popular Web
browsers can display GIF and JPEG (pronounced “jay-peg”) files.

GIFs

GIFs are the most widely supported graphics type on the Web (which means that almost all
browsers—old, new, and in-between—can display GIF images). GIF stands for Graphics
Interchange Format. CompuServe created this format in the 1980s as an efficient means to
transmit images across data networks. The GIF format’s main strength is that GIF images
are usually small, which means that they download and display quickly.

Lingo: GIF (Graphics Inter-
change Format) is a graphics
file format used to create im-
ages for use on the Internet.
GIF images can contain up to
256 colors.
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As we mentioned earlier in this lesson, GIF images use palettes and support up to 256
colors (which makes them 8-bit graphics). Because GIFs support a limited number of col-
ors, you should use GIFs for flat color areas, logos, line art, icons, cartoonlike illustra-
tions, buttons, horizontal rules, bullets, backgrounds, and other graphical elements that
require few colors. Figure 3-4 shows some examples of typical uses of GIF images.

Figure 3-4.
Line art, horizontal rules, buttons, bullets, and graphical text are typical uses of GIF
files.

In addition to being palette-reliant, small, and efficient, GIFs perform three
special tricks—interlacing, transparency, and animation.

• Interlaced GIFs Normally, a GIF image appears on screen row by row,
from top to bottom of the image, like pulling down a window shade. If you
want to, you (as a Web page designer) can change how a GIF down-
loads onto viewers’ monitors by saving your GIF file as an interlaced GIF
file. An interlaced GIF graphic displays on users’ screens as blurred or
jagged at first and then gradually becomes clearer. Figure 3-5 shows an
interlaced GIF in the midst of downloading. The figure on the left shows
the image before it’s fully downloaded, and the figure on the right shows
the fully downloaded image.

Figure 3-5.
On slower Internet connections, you can see how an interlaced GIF displays blurred be-
fore downloading completes.

If you’re using a fast Internet
connection, such as a cable
modem, you probably won’t
see the effects of interlacing.
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Interlaced GIFs are good to use when you want to transmit an image’s main idea to readers
while they wait for the complete download. The drawback of interlaced GIFs is that they
have slightly larger file sizes than conventional (noninterlaced) GIF images. Therefore, for
buttons, icons, and small graphics, you’re better off sticking to the conventional GIF file
format.

• Transparent GIFs Transparent GIFs (GIFs that use the GIF89a format)
enable you to design icons, logos, and other elements that appear to be
cut out, thereby allowing the Web page’s background to show through
areas of the image. For example, as you can see in the right side of Fig-
ure 3-6, the background shows through in the transparent GIF to create
the illusion of a nonrectangular image.
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Figure 3-6.
Comparing a standard GIF with a transparent GIF shows how transparency allows a
Web page’s background color (or pattern) to show through.

When you create a transparent GIF, you essentially specify a unique
color in your image to serve as your transparent color. For example, you
could color the background of your picture hot pink and then assign hot
pink to be the picture’s transparent color—just make sure hot pink
doesn’t show up elsewhere in your image or you’ll create unwanted
transparent spots. When a browser encounters the transparent color,
the browser doesn’t show any graphics information in the color’s area,
which enables the Web page’s background to show through.

• Animated GIFs The last GIF “trick” involves animation. Using GIF anima-
tion tools and graphics editing programs, you can layer GIFs and save
the layers in a “stack” to create simple animations. When a browser dis-
plays the stacked GIF images, it displays each image one after the other.
This technique is similar to the old flip-card “movies” that were popular
long before most of us came into existence. Moving icons, rollover but-
tons, and some banner ads are prime examples of animated GIFs. Fig-
ure 3-7 illustrates the theory behind animated GIFs. As you’ll see later in
this lesson, you can download free animated GIFs and GIF animation
tools from the Web.

Figure 3-7.
A series of GIF images can display in succession to create animations.

Tip
The Clip Art in Microsoft Office XP includes animated GIFs as well as transparent GIFs
that you can use on your Web pages. To identify a Clip Art item that’s an animated GIF,
look for a gold star in the lower-right corner of the thumbnail image in the Clip Organizer.
To identify a Clip Art item that has a transparent background, look for items that appear to
be “cut out” in the Clip Organizer. You can test an image’s transparency by inserting the
image into a Word document that has a color background.

If a GIF’s background color
matches your Web page’s
background color—such as an
image with a white background
on a Web page with a white
background—you automati-
cally achieve the illusion of
transparency.
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 “Safe” Colors for the Web
As you know, all computer systems are not created equal. Many people have a heck of a
time keeping up with the computer industry’s rapid pace of hardware development. There-
fore, when you design Web pages, you should keep in mind that not all people will be able
to access your pages if your pages require the latest and greatest display hardware. In fact,
approximately 10 percent of all Web surfers are restricted to viewing Web pages in 256
colors (although most new systems display millions of colors, so the 256-color design
issue will probably soon be a design consideration of the past). Therefore, for the next cou-
ple years, when you design your Web pages and create GIF images, you might consider
relying on colors that 256-color monitors can display without a hitch. The universal colors
are referred to as the Web-safe or browser-safe colors. If your Web page uses colors other
than Web-safe colors, systems that support only 256 colors will resort to dithering the
nonstandard colors.

To avoid dither, stick to the 216 Web-safe colors. (The other 40 colors out of the 256 are
reserved for the computer system’s use.) To see the Web-safe color palette, open pal-
ette216.gif in your graphics program. This file is located in the Lesson03 folder for this
course on your hard drive. To see the colors in color chart format, visit
www.creationguide.com/colorchart. Graphics editing programs usually provide a Web-safe
palette that you can load when working with GIF images.

JPEGs

In addition to GIF graphics, your Web pages will probably include JPEG images. The
JPEG image file format was created by and named after the Joint Photographic Experts
Group. This image format supports millions of colors, and JPEGs are almost universally
supported by browsers. (Technically speaking, JPEGs support 24-bit color, which is also
referred to as full color or true color.) Because JPEGs can contain millions of colors,
JPEG graphics frequently display photographic images online.

When you’re working with JPEGs for your Web pages, you can specify whether you want
to save your JPEGs as standard or progressive:

_ Standard When you save an image as a standard JPEG file, the image
loads line by line from the top of the screen down, similar to how GIFs
download by default.

_ Progressive When you save an image as a progressive JPEG file, the
image first appears blurry and then becomes more focused as the im-
age data is downloaded (similar to interlaced GIFs). With fast Internet
connection speeds, the progressive rendering might not be readily ap-
parent to viewers; instead, after a delay, the image will seem to “pop
up” onto the page. In our experience, progressive JPEGs seem to cre-
ate smaller file sizes and download slightly quicker than standard JPEG
files.

Another JPEG configuration parameter that you can use to your advantage is compression.
Compression is a process that reduces an image’s file size by throwing out some color in-
formation. JPEG compression is called a “lossy” compression scheme because once you
compress an image the deleted information is lost. Fortunately, if you’re careful, people
viewing the image online can’t easily discern the information loss.

Tip
When increasing a JPEG image’s compression, always save a copy of the
original image first. Then, use the Save As command whenever you further

Lingo: Dither refers to the
random dot pattern that results
when colors are approximated
by mixing similar and available
colors from a limited palette.

Lingo: JPEG (Joint Photo-
graphic Experts Group) is a
graphics file format used to
display photographic-quality
and other high-color images on
the Internet. The JPEG file
format can support millions of
colors.

When a JPEG image displays
on a system that supports only
8-bit color (256 colors), the
browser reduces the colors in
the image to the Web palette
and some dithering will occur.
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compress the file to create a new file. Once an image is compressed using
JPEG’s compression scheme, the information that’s removed is lost.

Keep in mind that the more you compress an image, the smaller the image’s file size be-
comes, but the resulting image won’t be as sharp as a less compressed image. Therefore,
you should experiment with various compression settings when configuring JPEG images
for your Web pages.

At this point, you should be comfortable with the idea of progressive and compressed
JPEG files, but we haven’t yet explained how to configure these types of settings for a
JPEG image. Fortunately, most image editing programs make specifying JPEG file pa-
rameters fairly easy. To access JPEG file settings in Paint Shop Pro, follow these steps:

1 Open your JPEG image in Paint Shop Pro. (Feel free to practice with
any of the fruit.jpg images provided for this course and located in the
Lesson03 folder on your hard drive.)

2 Choose Save As from the File menu to display the Save As dialog box.

3 Enter a new filename, and then click Options to access the Save Op-
tions dialog box, shown in Figure 3-8.

Figure 3-8.
The Save Options dialog box enables you to configure JPEG compression and render set-
tings in Paint Shop Pro.

4 Specify an encoding option (Standard or Progressive), select a com-
pression setting, click OK, and then click Save.

To configure JPEG settings in Photoshop, follow these steps:

1 Open your JPEG image in Photoshop.

2 Choose Save from the File menu.

3 Enter a file name, and click Save. The JPEG Options dialog box opens.
Specify compression settings by moving the Quality slider in the JPEG
Options dialog box, and then click OK.

PNG

The third (and final) graphic type we address in this lesson is the PNG file format. PNG
(pronounced “ping”) stands for Portable Network Graphics. Similar to GIFs, PNG files are
small, they load quickly, and they support transparency. PNG files transmit faster than
GIFs, but only the newer browsers support them.

Initially, the PNG file format was devised because Unisys, the makers of the GIF compres-
sion algorithm, decided to enforce the patents for that algorithm—meaning that software

Lingo: PNG (Portable Net-
work Graphics) is a graphics
file format designed to replace
GIF images on the Internet.
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vendors had to pay to use it. But you really don’t need to know the details about the PNG
vs. GIF debate. Just know that newer major browsers (including Microsoft Internet Ex-
plorer 5 and later) can display PNG images, but most Web designers don’t use PNGs in
deference to users who surf the Web with older or less technologically advanced browsers.
At this point, your Web pages probably shouldn’t use PNGs either.
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Note
Internet Explorer for Microsoft Windows began to incorporate some PNG support in 1997
and began providing PNG support in Macintosh versions of Internet Explorer in 2000.
Therefore, the PNG file format is slowly starting to catch on as developers watch the per-
centage of users who have access to the most up-to-date or most technologically advanced
browsers. From a developer’s perspective, there’s currently no reason to risk losing viewers
by using a PNG file format when the GIF file format is readily available, just as easy to
use, and widely recognized in almost all browsers (regardless of version).

Size Matters

The last major “technical” Web graphics consideration that we cover in this lesson is file
size, which is directly related to download speeds. As a Web surfer, you’ve probably
caught yourself drumming your mouse impatiently while waiting for pages that take longer
than 10 seconds to display (or, even more likely, clicking away before the slow page ever
fully displays). As a Web designer, you need to hold on to that impatient feeling. When
you design Web pages and use Web art, you should always keep one eye on your design
and another eye on the user’s perspective. (That almost sounds painful!)

When you use Web art, you can take advantage of a few techniques that will help keep your
file sizes manageable. We already covered a few key topics earlier in this lesson that can
help to reduce file sizes and speed download times, including these:

_ Avoid dither in GIF images by using Web-safe colors whenever possi-
ble, especially in large, flat color areas. (Just think—before reading this
lesson, that sentence wouldn’t have made a bit of sense to you.)

_ Configure JPEG images to render progressively.

_ Compress JPEG images to reduce file sizes.

In addition to using the three preceding graphics file techniques, you can control download
speeds by resizing your images, cropping images, and using thumbnails. We briefly de-
scribe each technique in the following sections. Please keep in mind that the actual me-
chanics of accomplishing certain tasks vary among graphics editing tools.

Resizing Graphics

One of the best ways to conserve download time is to physically resize your images in a
graphics editor. Note that we’re talking about resizing the image, not simply changing your
view. Zooming in and out changes your view of an image, but it doesn’t affect the file’s
actual size or dimensions. Try to size your images to the approximate size you want to
display them on your Web page. Figure 3-9 shows the Resize dialog box you use in Paint
Shop Pro to resize an image. To access the Resize dialog box, open the image and then
select Resize from the Image menu.

Keep in mind that smaller images result in smaller file sizes, which result in quicker down-
load times.

Usually, you’ll want to ensure
that the Maintain Aspect Ratio
option (or its equivalent in your
graphics program) is selected
when you resize graphics;
otherwise, you could distort
your images.
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Figure 3-9.
Resizing images to actual sizes in Paint Shop Pro helps to minimize download times.

Try This!
To experiment with resizing images, open a JPEG image in your graphics editor and then
change the image’s width or height setting.    Use the apples.jpg    image in the Lesson03
folder for this course on your hard drive. Save the JPEG image, and then repeat the process
a number of times using various measurements, renaming each version with a unique,
meaningful name (such as apples400w.jpg for a picture that’s resized to 400 pixels wide).
After you’ve created a few variously sized images, view the images locally in your browser
window—that is, either navigate to the figures by using your browser’s
Address toolbar or drag the JPEG images’ file name icons into your browser window.
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Sizing Images Just Right—A Quick Trick
When you first start to design Web pages, you might not know what sizes your graphics
should be. To help you resize a graphic to the size you want it to appear on your Web
page, you can use a Web editing program, such as Microsoft FrontPage.

To determine the optimal size for a Web graphic, follow these steps:

1 Insert the graphic into a blank Web page in FrontPage (for example)
and resize the picture by dragging the image’s selection
handles.

2 After the image is sized to your liking, display the image’s properties (in
FrontPage, right-click the graphic and select Picture Properties on the
pop-up menu), and note (and then write down) the image’s height and
width parameters.

3 Reopen the image in your graphic’s editing program and then resize the
graphic by entering the numbers you copied from FrontPage (or other
Web editing program) into the appropriate dialog box. For instance, in
Paint Shop Pro, you open the Resize dialog box by choosing Resize on
the Image menu, and, in MS Paint, you open the Attributes dialog box
by choosing Attributes on the Image menu.

Cropping Images

In addition to resizing an image, you can crop an image to reduce its size. When you crop
an image, you cut out the portion of the image that you don’t want to use. Cropping is
frequently used to remove any unwanted or unneeded portions of your photograph. For
example, you might want to crop the apples.jpg image shown in Figure 3-9 to show a
closeup of the green apple amidst the red apples in the colander. Figure 3-10 shows crop
lines (the dashed lines that surround the portion of the image you want to retain) in the
apples.jpg image, which is 50 KB, and the result of cropping apples.jpg. The cropped ver-
sion is only 6 KB.

Figure
3-10.
The crop marks indicate the portion of an image that will be used as a Web graphic. The
cropped image contains only the information you bounded by the crop marks.

Try This!
To crop an image, follow these steps:

1 Open an image in your graphics editor.

Lingo: Cropping refers to
cutting off a part of an image,
such as unnecessary portions
of a graphic.
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2 Click the selection tool (which usually looks like a dashed rectangle or
square in the application’s toolbar).

3 Click and drag in your image to outline the area of the image you want
to retain. (If you outline the wrong area, press Esc and try again.)

4 After you have an area selected, choose Crop To Selection (in Paint
Shop Pro) or Crop (in Photoshop) from the Image menu, or select a
similar command in your graphics editing program.

Using Thumbnails

After you master the art of resizing and cropping images, you’re ready to use thumbnails.
A thumbnail is a small picture that links to a larger image. (The larger image is usually the
same as the thumbnail, but we’ve seen some creative uses of thumbnails in our day.) When
you use thumbnails, viewers can choose to view the small image and be done with it or
they can click the thumbnail to view the larger image. In other words, when you use
thumbnails, you grant viewers the option to download large images if they’re willing to
endure the longer download times.

The trick to using thumbnails is to create two graphics with different names. Usually, you
use the same image for both graphics, and you make one image small with a quick down-
load time and the other image (while optimized to the best of your ability, of course) larger
with a longer download time. Then you display the small image on your Web page, and
you link the small image to the larger image. Figure 3-11 shows two thumbnails. The left
thumbnail displays the entire linked image, and the right thumbnail shows a cropped por-
tion of the linked graphic. Figure 3-11 also shows the larger graphic that’s linked to the
thumbnails. By clicking either thumbnail shown in Figure 3-11, you can open a window
displaying a large view of the apples.jpg image.

Figure 3-11.
Both thumbnails of the apples link to a sizable rendition of the apples.jpg
image.

Using Photographs
You probably have at least one boxful of prime Web art resources lying around your
home—photographs. You can use new and old photographs to add art to your Web pages.
The trick is getting the hard-copy picture turned into information your computer can under-
stand. To do that, you can use any of the following options:

Lingo: A thumbnail is a
miniature version or small
portion of a graphic. Fre-
quently, on Web pages, thumb-
nail graphics are hyperlinked to
larger versions of the graphic.
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_ Scanners Basically, a scanner takes a picture of your photograph and
saves the picture information as a file on your computer. After you have
a scanned picture, you can manipulate the file just as you manipulate
other graphics files. You can use any flatbed scanner on the market to
create Web graphics. You don’t need to get a top-of-the-line machine,
either. We use moderately priced scanners to scan most of our pictures.
If you don’t have a scanner and you aren’t planning to purchase one,
you can pay others to scan your pictures for you. For example, many
copy centers also scan pictures for a small fee.

_ Film developers and online photo services The next time you drop
off a roll of film for development, check out the services that the film de-
veloper offers. Many film developers can develop your film on CD, post
your pictures to the Web, send your pictures through e-mail, create
quality prints from digital pictures, and provide numerous other digitizing
services.

_ Digital cameras A third option for obtaining photographic images is to
use a digital camera. Digital cameras enable you to snap a photo and
then instantly send the picture into your computer. If you’re thinking
about buying a digital camera, here are a few issues to consider:

_ Cost Know your budget before you shop; most people don’t
need a top-of-the-line digital camera to get the job done. But,
with that said, don’t settle for “last year’s” model just for the sake
of saving a few bucks. Manufacturers are responding to the
growing demand for digital cameras; thus, they’re producing more
cameras (which lowers per-unit cost) and improving the cameras’
features. So buying a new camera at a camera shop can often
result in a better value than buying an older model at a discount
store.

_ Features Digital camera features run the gamut, but if you’re a
beginner, make sure your camera has automatic and manual fea-
tures. You’ll probably want to use the automatic features at first
to get the hang of digital photography. Then, after you’re com-
fortable using your camera, you can start to experiment with the
manual settings. Also, if you’re buying the camera only for Web
pictures, you can get away with a 1-megapixel (or lower) camera,
but if you want to be able to use your pictures online and in print,
consider getting at least a 1-megapixel (preferably at least a 2-
megapixel or 3-megapixel, if you can swing it) camera. Higher
megapixel cameras create better quality pictures and enable you
to print quality pictures at sizes larger than the standard snap-
shot size.

Finally, remember that digital cameras are basically handheld
computers. If you’re going to be taking pictures under all sorts of
circumstances and conditions, make sure you choose a camera
that’s built to withstand the torment. If you’re planning for some
truly extreme photography, consider checking out some of the
“weatherproof” models.

_ File Format Last but not least, a major point to consider when pur-
chasing a camera is to determine how easy it’s going to be for you to
get the pictures out of the camera and into your computer. Will you
need to use cables? Can you use infrared ports? Does the camera
store the pictures on a CD? Make sure you know how the camera trans-
fers pictures and that you’re happy with the method before you buy.

Lingo: A megapixel refers to
one million pixels, and it’s a
term used in reference to the
resolution of graphics devices,
such as scanners, digital cam-
eras, and monitors.
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Finally, as the last bit of advice in this lesson, regardless of how and where you obtain
your Web page graphics, remember to optimize your images and save them as GIF and
JPEG files. Make sure your images’ file sizes are as small as possible without compromis-
ing quality. Furthermore, store your images in a central location on your hard disk, and
don’t forget to give every graphic a unique and meaningful name.

Key Points
_ Online graphics are made up of pixels.

_ Most browsers support GIF and JPEG images.

_ GIF images are small, limited to a 256-color palette, and quick to
download.

_ GIFs can be interlaced, transparent, or animated.

_ JPEG images can contain millions of colors and are frequently used to
display photographs.

_ By default, GIFs and JPEGs display line by line from the top down, but
you can change the default by creating interlaced GIFs or progressive
JPEGs.

_ JPEG’s compression scheme enables you to reduce the size of JPEG
images, but the compression is “lossy,” so compress with care (remem-
ber, the more you compress, the lower your picture quality).

_ Size graphics in your graphics editing program to help make your Web
page’s graphics files as small as possible.

_ Cropping images reduces file sizes.

_ Consider using thumbnails to link to large online graphics.

_ Graphic Web page elements include photographs, illustrations, buttons,
logos, icons, bullets, horizontal rules, graphical text, and backgrounds.

_ You can acquire Web graphics from clip art collections on CD-ROMs,
online freeware, online art vendors, and graphic designers.

_ You can create custom art by using various software programs as well
as by scanning hand-drawn art.

_ Photographs can be converted to image files by means of scanners,
film developers, and digital cameras.


